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* Public Release 
 
Spin  Date  Fixes and Enhancements 
 
427* 06-01-2011 Fixed a problem where raster images falling outside of viewport 

boundaries were being improperly plotted in PDF. 
 
   Fixed a problem where certain raster image files were not plotting 
   in .pdf plots 
 

Set the Details Plug-In parameters file to always be in the User 
Home directory which is always writable to the user, thus fixing a 
permissions problem in cases where the Standards directory is not 
writable to the user. 
 

  
426* 03-18-2011 Fixed a problem where some True Type text fonts were not 

justifying properly  when plotted from the Plot Preview menu. 
 
 
425  03-11-2011 Internal testing. 
 
 
424*  02-22-2011 Fixed a where Repeated Items which have Attributes associated 

with them were listing twice in the RI Select menu and not 
displaying properly in the menu and when placed. 
 
Fixed a problem where some True Type text fonts were not 
justifying properly when plotted to .pdf. 

 
Fixed a problem where the Viewport Layer Lock display on the 
Project Page Select menu was not displaying Lock By Sheet 
properly. 

 
 
423*  01-25-2011 Fixed a problem in the Edit menu where the Entity Filter Color 

parameter was displaying a menu range color incorrectly if the filter 
color falls in the old 256 shaded band colormap menu range. 
 
Fixed a problem in the Dimension String special edit where 
changing a manual dimension to automatic was not working 
properly. 
 
Enhanced the Add, Delete, and Move Vertex functions in the 
Pattern Geometry Edit commands so that the selected Pattern 
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boundary remains selected until an <Enter> or F10 entry is given 
for the Vertex. This allows you to add, delete, or move multiple 
vertices on the selected Pattern boundary without having to 
reselect the Pattern. 
 
Enhanced the Add, Delete, and Move Vertex functions in the Zone 
Geometry Edit commands so that the selected Zone boundary 
remains selected until an <Enter> or F10 entry is given for the 
Vertex. This allows you to add, delete, or move multiple vertices on 
the selected Zone boundary without having to reselect the Zone. 
 
Enhanced the Add, Delete, and Move Vertex functions in the  
Polyline Geometry Edit commands so that the selected Polyline 
remains selected until an <Enter> or F10 entry is given for the 
Vertex. This allows you to add, delete, or move multiple vertices on 
the selected Polyline without having to reselect it. 

 
Fixed a problem where during edits, the specified Edit Window is 
corrupted when mouse wheel zooms or pans are performed, 
causing unexpected results in the edit. 
 
Added a setting to the User Preferences menu under the Crosshair 
/ Mouse section which disables the middle mouse click. The setting 
may be turned On (disable the click) or Off (the default). This is 
designed for users who use the mouse scroll wheel for zoom and 
pan and inadvertantly click the middle mouse button causing an 
unintentional point input. 

 
 
422  01-12-2011 Internal Testing 
 
 
421  11-08-2010 Internal Testing 
 
 
420  11-05-2010 Internal Testing 
 
 
419  10-18-2010 Internal Testing 
 
 
418* 10-07-2010 Fixed a problem where the user custom startup file ustart.tx was 

not being properly executed during BuildersCAD startup. 
 
Fixed a problem where text placed with true-type fonts was plotting 
(and also printing to PDF) offset from it's proper location. 
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Fixed a problem where raster images placed in Sheets were 
rotating 90 degrees on each redisplay. 
 
A reported problem where creating a PDF using 2 point, fit to page 
did not properly size and fit the drawing to the paper has been 
verified as working properly in this spin. Note that the desired 
margins for the PDF page must be properly set in the Export To 
PDF menu. 

 
 
417*  10-01-2010 Corrected a problem where the Pattern icon is not being created 

properly when making a new Pattern Entity Style in the Pattern 
Create menu. 
 
Fixed a problem where some of the BuildersCAD Styles Catalog 
brick patterns give an error when placing them. 
 
Fixed a problem wher when making a .pdf of a drawing, certain text 
placed at a 45 degree angle is flipped 180 degrees in the .pdf. 
 
Fixed a problem where the double slash network designation on 
"Network Neighborhood" file paths was not being properly held. 
This was most noticeable in the Database Drawing/Sheet Select 
menu. 
 
Increased the number of Revisions allowed in Sheets from 99 to 
999. 
 
Fixed a problem in Elevations where patterns were being placed 
with boundary retain set to "On". 
 
Fixed a problem on the Slab/Path menu where the Remake Slab 
button left click was not executing the command properly. 
 
Restored the Attribute button to the Entity Filter section of the Edit 
menu. 
 
Altered the View menu so that the Winport button under the Zoom 
heading allows you to define a zoom window in one Winport and 
display it in another. The Zoom Extents and Display (Display All) in 
all Winports that was previously under this button has been moved 
to be the default right-click on the All Winport button under the 
Special Display heading. The Redisplay All Winports (current 
zoom) remains the left click command under the Special Display - 
All Winport button. 
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Fixed a problem where BuildersCAD would not properly update 
existing Thumbnails. 
 
Fixed a problem in the Project Page List Manager where the 
Project variables used in selection were not being properly reset 
when the program exits. 

 
 
 
416*  05-04-2010 Fixed the Wall Label icon and placement symbol on the Label Walls 

menu to be the arrow head as in previous versions of BuildersCAD. 
 
Revised the Viewport Layout menu for graphics and menu help. 
 
Added a new function to the Viewport Layout menu which will 
replace existing Viewports on a Sheet with a Viewport from the 
same database if a Viewport file exists in that database. 
 
The Recent Documents box on the File pull-down menu has been 
moved to be grouped with the other "Open" functions. 
 
The Recent Documents function has been completely overhauled. 
This feature is now a part of the Project Page / Database 
Drawing/Sheet/Thumbnail Select menu. It is still called from the File 
pull down menu and a right click on the File icon on the Desktop 
menu, which now open the Project Page / Database 
Drawing/Sheet/Thumbnail Select menu in Recent Documents 
mode. BuildersCAD now saves the last 12 documents opened and 
the documents are presented in the menu in the same Project 
Mode that was current when the document was last opened. This 
allows all of the functions on the "Open" menus to now also apply 
to Recent Documents, including Plot, PDF, eZ, etc. 
 
A "DR/SHT LIST FILE" button has been added to the Project Page 
/ Database Drawing/Sheet/Thumbnail Select menu. This button will 
list Pages/Drawings/Sheets/Thumbnails to a text file and then open 
it in the default text editor where it may be viewed, saved, or printed 
as needed. In Project Mode the list contains all Page names, 
descriptions, and drawing/sheet references for the selected Project 
grouped by Category. In File Mode the list contains all drawings, 
sheets and thumbnails with descriptions for the currently selected 
database in the menu. In Recent Documents mode the list contains 
the Project Number, Project Name, Page Name, Page Description, 
and full file path or the database, drawing/sheet/thumbnail name, 



BuildersCAD 9.4 Update Notes 

Page 5 of 9 

drawing/sheet/thumbnail description and full file path for all 
documents currently on the Recent Documents list. 
 
Fixed a problem in the Project Page / Database 
Drawing/Sheet/Thumbnail Select menu where the BCAD 
Application saved with a Thumbnail was not being properly loaded. 
 
Changed the display of Thumbnails in the Project Page / Database 
Drawing/Sheet/Thumbnail Select menu so that Thumbnails are not 
shown as being "In Use". Any database that was loaded would 
show all Thumbnails as "In Use" which was misleading. The 
master.dr of the database will still display as "In Use" if the 
database is loaded. 

 
Enhanced the Layer Manager Load/Copy function so that the layer 
list for a database to load/copy from is now read from the master.dr. 
of that database. This greatly improves the speed with which the list 
is displayed to the menu. The list is still sorted by layer number by 
default, and may still be sorted by layer name by selecting the title 
bar above the list. 
 
Enhanced the Pattern Placement command by adding a prompt for 
the Pattern Origin point if the Pattern type is "Line" or "Repeated 
Item". The Pattern origin determines the exact location of a line or 
RI pattern fill within the Pattern boundary, and was previously 
automatically placed at the first point in the Pattern boundary. The 
new prompt occurs after "Fill" is selected to end boundary input and 
place the Pattern, and does not occur if the Pattern Type is "Solid 
Fill". 
 
Fixed a problem in the Pattern Geometry Edit function where the 
pattern origin was not being properly replaced in the same location 
during edits. 
 
Fixed a problem in the Edit menu where the Line / Wall Type filter 
was being automatically set to type 0 when Lines/Walls were 
selected as the entity filter. 
 
Updated the Elevations Application Surfaces menu to use the 
improved Pattern Placement routines. All Pattern boundary 
definition commands and Geometry Edit functions are now 
available on this menu. 
 
Removed a restriction in the Layer Manager where changing the 
layer number of a layer if the permission on the layer is read-only 
was not allowed. 
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Fixed a problem on the Sheet Create menu where the file type icon 
was overwriting the beginning of the file name on the left side of the 
menu if the menu is stretched out on a wide screen but wide screen 
mode is off. 
 
Fixed a problem where PDF files were being created with an offset 
under certain conditions. 
 
The BuildersCAD Encyclopedia has been updated to reflect recent 
changes and additions. 

 
 
 
415*  01-26-2010 Fixed a problem in Pattern Edit where the work layer was not being  

properly restored if the edited Pattern is not on the current work 
layer. 
 
Fixed a problem in Zone Edit where the work layer was not being 
properly restored if the edited Zone is not on the current work layer. 

 
Fixed a problem in Polyline Edit where the work layer was not being 
properly restored if the edited Polyline is not on the current work 
layer. 
 
Fixed a problem in placing a Pattern by selection of an existing 
Polyline where the Polyline arc segments were not being read 
properly. 
 
Fixed a problem in placing a Zone by selection of an existing 
Polyline where the Polyline arc segments were not being read 
properly. 
 
Fixed a problem where the closing segment of a Polyline was not 
being drawn properly in the Polyline Edit Freeze function. 

 
The Polyline Freeze function may now be called from the general 
Edit menu. The Entity Filter must be set to Polyline and the Search 
criteria must be set to Single. 
 
Consolidated the temporary directory BuildersCAD uses to the 
environment variable "TEMP". This is set automatically by default to 
the MS Windows temporary directory. The environment variable 
"GSWAP" is obsolete and no longer used. 
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Enhanced the Layer Manager Load/Copy Layer function for faster 
display of the layer list. 
 
Layer Manager - In the Load/Copy Layer function when a drawing 
is selected the list of layers now pages to the first selected layer 
instead of displaying from the top of the list. This gives a better 
visual indication of the layers selected, particularly if the database 
selected to load/copy from has a large number of layers. 
 
Layer Manager - In the Load/Copy Layer function the layer list title 
bar now shows the total number of layers available for selection in 
addition to the number actually selected. 
 
Layer Manager - In the Load/Copy Layer function a Search Layer 
button has been added. When selected, ARRIS will prompt for the 
layer name to search on the Load/Copy Layer list. If found the layer 
will be selected and the display will page the list to display the 
searched layer name. 
 
Expanded the maximum length of choices for input in BuildersCAD 
to 256 characters (previously 64). 

 
 
414  01-08-2010 Internal Testing. 
 
 
413*  11-25-2009 Improved the speed of layer display and sorting in the Layer 

Manager. 
 
In the Layer Manager, the Layer Sort function has been disabled 
while a Sheet is loaded. Layer Sort is not needed in Sheets since 
there are only 2 active layers which are displayed at the top of the 
Layer list. After a sort if the 2 active layers were not at the top of the 
list, the modes could not be manipulated. Layer Sort is unchanged 
while a Drawing or Viewport are currently loaded. 

 
    Fixed a problem in Notes where the Note and leaders were not 
    being placed properly in the Edit - Remake function. 
 

Notes feature - the Edit - Revise Text function has been enhanced. 
It works similar to before in that it puts the Note text into the default 
text editor for changing. When the text is saved and the text editor 
is closed, the revised Note is now updated to the Note entity in the 
database immediately (as well as to the Edit Note menu). This 
means that a "Remake Note" is no longer required to update it. The 
revised Note is replaced with it's previous parameters including  
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type (keynote or text note), mask, and frame regardless of the 
current settings. Leader locations also remain unchanged so a 
"Remake Note" may be required to update them, particularly for 
right leaders. 
 
Notes Feature - A new "Move Leader Point" button has been added 
to the Edit Note menu which allows you to move a single leader 
point on the Note selected for edit. The leader point must be 
selected using the F11 key. The cursor will form a rubber-band 
aiding in the placement of the new point location. The Note will be 
updated immediately and ARRIS will prompt for another leader 
point to move. An <Enter> Key or F10 input at this prompt will 
restore the Edit Note menu. 
 
Notes Feature - Text edits of keynotes are now allowed. Even 
though the text is not displayed in the database, it is carried with 
the Note entity. 
 
Notes Feature - The Edit Notes menu has been enhanced such 
that a right click selection on the "Revise Text" button or on the 
Note display will refresh the highlight of the Note selected for edit in 
the database. This is sometimes necessary particularly if the Text 
Editor is used or the screen is redisplayed. 
 
Fixed a bug in Notes where a revised note from the Edit Note menu 
was sometimes not replaced on the proper layer. 
 
Added Polylines as a searchable boundary type in the Query Area 
feature. 
 
Added Patterns as a searchable boundary type in the Query Area 
feature. The area of the pattern is reported as a whole, meaning 
sub-boundaries of the pattern are added or subtracted from the 
Pattern in the same way the Pattern is displayed before the Pattern 
area as a whole is reported/added/subtracted in the Query Area 
menu. 
 
Added Polylines as a searchable boundary type in the Query 
Perimeter feature. 
 
Added Patterns as a searchable boundary type in the Query 
Perimeter feature. The perimeter reported is the sum of the Pattern 
boundary and all sub-boundaries. 
 
Added Feet/Inches as a display unit to the Query Perimeter feature. 
It is the default unit when the Query Perimeter menu is first started. 
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When Feet/Inches are displayed, total length is displayed to the 
32nd of an inch and the Decimal setting is disabled. 
 
In the Color Mix feature, adjusted the menu color numbers to reflect 
the current range of colors beyond the standard 256 colormap color 
range instead of the old 256 color shaded band colormap numbers. 
 
Fixed a problem where the DWG/DXF Translator was not being 
called properly from the BuildersCAD Export menu. 
 
The Import and Export menus called from the File pull-down menu 
have been updated. 
 
When the DWG/DXF Translator menu is called from BuildersCAD, 
the translator application libraries are now automatically reloaded. If 
the translator is not installed, BuildersCAD now gives an error 
message. 
 
Fixed a problem where the "Create LP File" function in 
BuildersCAD 3D was looking for files in an old location and giving 
an error. 
 
The Zone Placement commands have been updated for better 
control of marker and Zone placement. The look and feel of Zone 
placement is now similar to Patterns and Polylines. 
 
The Zone Placement function has been enhanced to include 4 new 
placement options. In addition to placing a Zone by Points, 
Rectangle, and Chase, you can also place a Circular Zone 
boundary, or define a boundary by selecting an existing Pattern or 
2D Polyline in the database. 
 
The Zone Placement function has been enhanced to include a 
"Backspace Point" function which removes the last boundary 
segment entered while defining a Zone boundary, and then allows 
you to continue defining the Zone boundary from there. This 
function is executed by selecting the "BSP" button on the Zones 
Application Sub-menu, or by pressing the UNDO button while 
placing a Zone boundary. 
 

 
 
412  10-30-2009 Internal Testing. 
 
411*  10-23-2009 BuildersCAD 9.4 Release 


